—

BéNQ

GH610/ GH618
Digital Camera
User Manual

\\§\$
Downloaded from M anua sCamera.com Manuals

/

4
/.
/7.
777/
7/
7
/,
I:,(

/
/
/,
/
/
')


http://manualscamera.com

Copyright

Copyright 2013 by BenQ Corporation. All rights reserved. No part of this
publication may be reproduced, transmitted, transcribed, stored in a retrieval system
or translated into any language or computer language, in any form or by any means,
electronic, mechanical, magnetic, optical, chemical, manual or otherwise, without the
prior written permission of BenQ Corporation.

All other logos, products, or company names mentioned in this manual may be the
registered trademarks or copyrights of their respective companies, and are used for
informational purposes only.

Disclaimer

BenQ Corporation makes no representations or warranties, either expressed or
implied, with respect to the contents hereof and specifically disclaims any warranties,
merchantability or fitness for any particular purpose. Further, BenQ Corporation
reserves the right to revise this publication and to make changes from time to time in
the contents hereof without obligation of BenQ Corporation to notify any person of
such revision or changes.

This user manual aims to provide the most updated and accurate information to
customers, and thus all contents may be modified from time to time without prior
notice. Please visit http://www.beng.com for the latest version of this manual.
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Do not hold the camera by excessive To avoid accidental falling, please attach
force. Plus, be sure to protect the the neck strap to the camera and always
camera from strong impacts. put the camera around your neck.

If the batteries suddenly depleted and When the camera is not in use, always
caused the lens fail to retract, please turn the power off. Plus, before storing
carefully protect the lens to avoid the camera in its case, make sure the lens
collision and insert batteries with full has retracted successfully and you put the
power ASAP. lens cover back. If you do not intend to

use the camera for a long time, please
remove the batteries from the camera and
store the batteries carefully.

Keep your camera away from sharp When the camera is not in use, please

objects and avoid collision. place it in the pouch and a steady place.
Plus, always keep your camera away from
pressure to avoid possible damage.
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Touring the camera

Checking the package contents

Carefully unpack your kit box and ensure that you have the following items.

Quick Guide

Digital camera

USB cable

AA battery x 4

Neck strap

Software & User Manual CD
Pouch (optional)

Lens cover

Lens strap

VN AW —

* All pictures, screen captures, and icons used in this manual are for illustration
0 only. Actual and available products, accessories, as well as their appearance may
vary depending on sales region.
* If any items are missing or damaged, contact your dealer.
* Save the packaging for future shipment or storage.
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8 Touring the camera

Camera

Front and bottom views

9

© N LA WD —

Lens

Microphone

Zoom lever

Shutter button

Strap eyelet

Power button

AF Assist Lamp / Self-timer LED indicator
Mode dial

Flash

10.Speaker
I'1.Tripod mount
12.Battery/card cover
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Rear view

LCD display

Status LED

O N O AW N~

LED Indicator

USB / AV port
PLAYBACK button [>]

RECORD button @
Multifunctional buttons (including a 4-way control and an OK button)

Function / Delete button Fn-TJ
MENU button MENU

Indicator State Description
Status LED No light The digital camera is off.
Solid green * The digital camera is ready to capture
images.
* The digital camera is powering on, or is in
the power-saving mode.
Status LED Blinking green |+ The digital camera cannot focus.

* The digital camera is capturing a video clip.
* The flash is charging, or the USB
communication/transfer is in progress.

Self-timer LED

Blinking red

The self-timer function is activated.
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o * It is normal for the camera to become warm during operation, because the

camera casing might conduct heat.

The LCD display on this camera is manufactured with sophisticated technology,
and more than 99.99% of the pixels on the LCD display meet standard
specifications. Yet, it is possible that less than 0.01% of the pixels on the LCD
display may have some light spots or show unusual colors. This is normal and does
not indicate display malfunction, nor will this affect the pictures you take with the
camera.

The LCD monitor looks darker in strong sunlight or bright light. This is not a
malfunction.

To prevent your images from being blurred while pressing the Shutter button,
always hold the camera steady. This is especially important when you are shooting
under low lighting conditions, under which your camera may reduce the shutter
speed to ensure your images are properly exposed.

Multifunctional buttons

You can choose camera settings by pressing the 4-way control or OK.

Left/Focus:

* Scrolls left in menus.

* Toggles between different focus modes.
Up/Face Tracking:

* Scrolls up in menus.

* Turns on/off Face Tracking. See "Face

Tracking" on page 21 for details. /
* Rotates an image. See "Rotating an image" on

page 48 for details. > 4

. Right/Flash:

* Scrolls right in menus.
* Selects a flash mode.

. Down/Display:

* Scrolls down in menus
* Toggles between different display modes.

. OK: Confirms a chosen setting.

Downloaded from ManualsCamera.com Manuals



http://manualscamera.com

Touring the camera ||

Preparing the camera for use

This section will guide you on how to prepare the camera before its initial use.

Attaching the strap

To attach the lens and neck straps to your camera, do the following:
I. Insert one end of the neck strap through the strap eyelet. N

2. Route it through the buckle as the inner loop.

2N

3. Route the other end of the neck strap to the other strap
buckle to secure it.
Follow the above steps to attach the other side of the
neck strap.
,/

/

4. Insert one end of the lens strap through the strap eyelet.
Make a loop to secure it.

5. Attach the other end of the lens strap on the lens cover.
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6. Once complete, make sure the straps are tight.

* Wrapping the strap around your neck is dangerous. Refrain children from playing

o with the strap.

* Remove the lens cover before using the camera.

Installing the batteries
Use only the specified batteries for the camera, and always turn off the camera
before removing the batteries.

To install the batteries:
I. Push the button up and then slide the battery/card

cover to the right to release and open it.

2. Insert the batteries in the correct direction by matching
the + - label on the battery slot.

3. Close the battery/card cover and then slide it to
the left to lock it in place.
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To remove the batteries:

I. Push the button up and then slide the battery/card cover
to the right to release and open it.

2. Remove the batteries.

3. Close the battery/card cover and then slide it to the left
to lock it in place.

* Turn off the camera before removing the batteries.
o * Use only the specified battery type. Using other types of batteries may damage
the camera and invalidate the warranty.
* Ensure that the batteries are inserted into the product with correct polarity.
Incorrect polarity may damage the camera or cause fire.
* Download all pictures and remove the batteries from the camera if you are going
to store the camera for a long time.
* The batteries may be warm after being used. This is normal and not a malfunction.
* When using the camera in a cold environment, keep the camera and its batteries
warm by holding it inside your jacket or another warm protective environment.
* Please select the correct battery type before use (see "Battery Type" on page 46
for details).

* High-capacity (such as 2500 mAh) rechargeable batteries are recommended.

* Carbon-zinc batteries are not recommended.

* The AA batteries that came with the camera are not rechargeable.

* Do not combine old and new batteries or batteries of different makes or types.

* Performance of alkaline batteries may vary greatly depending on the manufacturer.
Choose a reliable brand.
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Installing an SD card

The camera comes with internal memory for storing captured images, video

clips, or audio files. You can also add an SD card to store more files.

To install an SD card:

|. Push the button up and then slide the battery/card
cover to the right to release and open it.

2. Insert an SD card in the correct direction.

3. Close the battery/card cover and then slide it to
the left to lock it in place.

To remove an SD card:

|. Push the button up and then slide the battery/card cover to the right to
release and open it.

2. Lightly press the edge of the memory card to eject.

3. Close the battery/card cover and then slide it to the left to lock it in place.

Before initial use of an SD card, please format the card first by pressing MENU >

[3<] > Manage Memory > OK / 3 > B Format > OK > Yes.
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Turning the Power On and Off

o Before turning on the camera, be sure to remove the lens cover. Otherwise, the lens
will not be extended and the camera will beep three times.

There are two ways to turn on the camera:
* Press the Power button.
The zoom lens extends and the camera is turned on in Record mode.
¢ Press and hold [»].
The camera is turned on in Playback mode, and the lens is not extended.

Opening the Flash

You need to manually open the flash before switching the flash mode.
To open the flash:

Use hands to lift the flash to open it.

To close the flash:
Push down the flash to close it.

o When the flash is closed, flash mode is automatically set to flash off.
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Initial setting

You will be prompted to set up the language and the date and time when the
camera is turned on for the first time.

Setting language
Selects the language version shown on the screen.

To select a language:
I. Press MENU > [3:€]. (Step | is needed only

after the initial setting is complete.)

Espariol
2. Press [_..]6 or |O| to locate Spanc
dth Deutsch
TEE [ EE
Language / ;5% /&% , and then press OK or Francais e
i, Itali Romaéana

3. Press m, i, [_’_]6' or IDI to locate &5 OK [E0 Back

the language you want.
4. Press OK to set the language.

Setting date and time

When using the camera for the first time or when the battery has been removed
from the camera for a long time, you need to set the date and time. The date
and time is recorded when a video or image is captured.

To set date and time:
I. Press MENU > [3x€]. (Step | is needed only

after the initial setting is complete.)
2. Press [_._]6 or || to locate Date/ (2071 Pt | i

Time, and then press OK or 3 YY /MM/DD
3. Press [_._] C or |D| to select date, time

Back

and date format. Press $ or 3 to move
to another column as needed.

4. Press OK to set the date and time.
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Operating the camera

The procedure below is a general guideline for basic operation. It is particularly
useful if you are new to the camera.
|. Press the Power button to turn the power on.
Be sure that you have removed the lens cover before turning on the camera.
2. Set the mode dial to P or other desired shooting mode. See "Selecting the
Shooting Mode" on page 23 for details.

o Remember to follow the on-screen display or slide the Zoom lever to W for

instructions (wherever available). Next, press the corresponding buttons to access
and set more options. At any time, you can cancel the current operation by pressing
MENU to return to your previous step.

3. If you need to use the flash for shooting, open the flash.
. Use the Zoom lever to zoom-in/zoom-out on the subject.
5. Press the Shutter button halfway to set automatic focus.

* Once the focus is set, the focus frame color will turn from white
(unfocused) to yellow-green (focused). If the focus frame color is red and
you press the Shutter button down, it might result in a blurred photo.

6. Press the Shutter button down fully to capture the image.

N

7. To switch to Movie mode, press @. The video recording automatically
starts.
* While recording, use the Zoom lever to zoom-in/zoom-out on the subject.
Press @ again to stop video recording.

* Press [_._] G to pause/resume the video recording.

8. To switch to Playback mode, press [®]. In Playback mode, you can view
captured images or recorded videos.
* You can press $ or i to view other images/videos, slide the Zoom lever

to W to zoom-in on a captured image, or slide the Zoom lever to QT
side to view 9-thumbnail images on the screen.

Digital Zoom

[m——__ T
I

Optical Zoom
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o * During zoom-in/out, there is a separator in the zoom bar between T~ and W/.
For best image quality, it is recommended to use optical zoom only by keeping the

magnification within Y/ and the separator.

* Flash is automatically turned off in the Movie mode.

* In Movie mode, the camera records both sound and video. The recording time is
continuous, but recording will stop once the memory card space is full.

* In Movie mode, sound is temporarily muted during zoom-in/out.

At any time, you can press the Power button to turn off the camera.

* In Capture or Playback mode, press |(J| to decide what information to

show on the screen.
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Capture mode
I 2345

0 &HESW

17 16 15 1413 1211
Item Description Page reference
| Shooting mode 23
2 Flash mode 20
3 Focus mode 22
4 Drive mode 42
5 O.LS. (Stabilizer) 44
6 Number of shots available -
7 Image size 36
8 Image quality 36
9 Movie size 37
10 Face Tracking 21
I ISO 38
12 White Balance 37
13 AE metering 39
14 Exposure value (EV) 37
I5 AF area 42
16 Histogram -
17 Battery status 44
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Description Page reference

18 Camera shake warning -

* In Capture mode, press |(J| to toggle among the 4 display modes (standard,

complete, none, and rule of thirds).

* Use the rule of thirds display mode to improve your composition by placing
subjects on at least one of the intersections of these 4 imaginary lines.

* While the shutter is pressed down halfway, the AF area color changes to yellow-
green. Camera shake warning (appears only if the camera itself detects possible
shaking), aperture, shutter speed and ISO setting are also shown on the screen.

Flash mode

The flash offers additional light source (usually used in a low-light environment).
You can capture an image using one of the following flash modes.

Icon

%

Mode
Auto Flash

Description

The flash fires automatically based on the
photographic conditions.

@

Auto Anti Red-
eye

Reduces the red-eye phenomenon when
capturing natural-looking images of people
and animals in low-light conditions. Be sure
to ask the subject to look at the camera lens
or get as close to the camera as possible.
The flash fires automatically based on the
photographic conditions.

Force On

The flash always fires regardless of the
surrounding lighting conditions. Select this
mode when capturing images with high
contrast (backlighting) and deep shadows.

Slow Sync

Fires the flash immediately at the beginning
of exposure with a longer shutter speed, so
balanced ambient lighting of the foreground
subject and background scene can be
reached in a low-light environment.
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Description

Force Off The flash does not fire. Select this mode
when flash photography is prohibited, or
when the distance to the subject is beyond
the effective range of the flash.

To select a flash mode:

I. Set the mode dial to the desired shooting mode. See "Selecting the Shooting
Mode" on page 23 for details.

2. Open the flash. See "Opening the Flash" on page |5 for details.

3. Press i repeatedly until your desired flash mode is displayed on the LCD
monitor.

o * The flash mode is not available in Continuous Shooting and Panorama modes.
* The flash mode will remain at “Flash Off” if the flash does not open.
* When the flash is closed, flash mode is automatically set to flash off.

Face Tracking

Focuses on the position of faces (max. |0 faces) simultaneously. While using the
Face Tracking function, point the camera to where the people (your subjects)
are located. Focus frames of Face Tracking will automatically detect faces
(maximum 10) and show on the LCD screen.

To enable face tracking:
I. Set the mode dial to the desired shooting mode. See "Selecting the Shooting
Mode" on page 23 for details.

2. To enable this function, press [!] G.

A icon appears on the LCD monitor.

* To disable face tracking function, press [@1¢, again.

* This function is not available on most of capture modes. The camera will
automatically determine the availability of this function.

* Due to environmental factors such as lighting, the number of detected faces might
be different from that of the actual faces.

* To achieve the best result, ask your subjects not to turn their faces partially away
from the lens.
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Focus mode

Icon Mode Description
) Auto focus Adjusts focus automatically.
Macro Used when capturing images at a close

&

distance.

&S

Super Macro

Used when capturing images at a very close
distance. Super Macro mode is automatically
selected when capturing subjects from a
very close distance, and is not available for
manual selection by the user.

&3 Pan Focus Used when you want to capture the subjects
in a certain focus range.
3 Infinity Used when capturing images at long

distance.

To select the focus mode:
I. Set the mode dial to the desired shooting mode. See "Selecting the Shooting

Mode" on page 23 for details.

2. Press a repeatedly to toggle between Auto focus and focus modes.
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Selecting the Shooting Mode

Rotate the mode dial to select one of the eight shooting modes:

No. lcon Mode Description

l. P |Program The camera automatically configures the
appropriate settings, so you can capture images

with ease.
2. Tv [Shutter You can choose a shutter speed, while the aperture
Priority value is automatically determined by the lighting

condition of the subject. See "Using Shutter Priority
mode" on page 24 for details.

3. | Av |Aperture |You can choose an aperture value, while the
Priority shutter speed is automatically determined by the
lighting condition of the subject. See "Using
Aperture Priority mode" on page 24 for details.

4. M |Manual Lets you set both aperture and shutter speed
manually. See "Using Manual mode" on page 24 for
details.

5. IEI Continuous | Lets you capture a series of shots with a single press

Shooting  |of the Shutter button. See "Using Continuous
Shooting mode" on page 25 for details.

6. Panorama |Lets you create a panoramic photo from three
shots. See "Using Panorama mode" on page 25 for

details.
7. | SCN |Scene Lets you select the desired scene mode that suits
Mode your shooting environment. See "Setting the Scene

mode" on page 27 for details.
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No. Icon Mode Description

The camera detects the shooting condition and

Scene automatically switches to the appropriate scene
mode. See "Using Smart Scene mode" on page 27
for details.

Using Aperture Priority mode

Aperture priority is often used when shooting static subjects or emphasizing the
depth of field. In general, use a smaller aperture if a greater depth of field is
needed.

To adjust aperture value:

|. Set the mode dial to Av.

2. Press OK.

3. Press [_._] G or |O| to adjust the aperture value.
4. Press OK to confirm setting.

Using Shutter Priority mode

Shutter priority is often used when shooting moving subjects. In general, use a
shorter shutter speed to catch a fast-moving object.

To adjust shutter speed in Shutter Priority:

|. Set the mode dial to Tv.

2. Press OK.

3. Press * or i to adjust the shutter speed.
4. Press OK to confirm setting.

Using Manual mode
You can choose the aperture value and shutter speed in Manual mode.

To adjust values in Manual mode:
I. Set the mode dial to M.

2. Press OK.

3. Adjust the settings.

* Press [_._] G or |O| to adjust the aperture value.

* Press $ or i to adjust the shutter speed.

4. Press OK to confirm setting.
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Using Continuous Shooting mode
In this mode, you can take consecutive shots.

Icon Mode Description

Burst Continuously takes pictures as long as you
keep pressing the Shutter button. The flash
is always off in this mode.

Speedy Burst Press and release the Shutter button. When
Gy

the photo size you select is VGA, Speedy
Burst will shoot continuously at the speed of
30 shots per second. This will stop after |
second or when the memory card is full.

AEB (Auto Automatically takes 3 pictures with slightly
AEB
Exposure different settings in the shutter speed or the
Bracketing) aperture value.

To select a continuous mode:
I. Set the mode dial to .

2. Press [!_] G to enter the select mode. Speedy Burst

3. Press $ or 3 to select a desired option. © [Fﬁ'l ﬁ%
4. Press OK to confirm. F “.‘i
F w"'

Using Panorama mode

Creates a panoramic photo from multiple shots. Two to three shots are stitched
into one single and seamless large picture.

|. Set the mode dial to [=].

2. Press [!] G to select how shots will be stitched.
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3. Press the Shutter button to capture the first shot.

Description

@ Left-to-Right The direction of the succeeding shots will be
to the right of the first shot.

=10 Right-to-Left The direction of the succeeding shots will be
' to the left of the first shot.

4. A guidance bar appears on top of the screen. The screen icon @ indicates
the location of the current screen. Pan the camera following the guidance
arrow.

Guidlance bar

5. Once the screen icon @ overlaps the green block, the camera will
automatically take the second shot. If you will only stitch two shots, press
OK to complete the panoramic picture. Otherwise, proceed to the next
step.
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6. To take the third shot, pan the camera to the direction of the guidance arrow.
Once the screen icon overlaps the green block, the camera will automatically
take the third shot.

The camera captures the shot when  Panoramic picture preview
the screen icon overlaps the block

Using Smart Scene mode
Automatically selects the best scene mode from Portrait , Landscape ,
Sunset [g3y. Backlight [, Backlight Portrait Night Portrait [gg, Night

) A
Scene a@, Snow EF, Text [l and Foliage &8, and Macro &5.

I. Set the mode dial to K.

2. Press the Shutter button halfway to set automatic focus. The selected
shooting mode is displayed in the top left corner of the screen.

3. Press the Shutter button to capture an image.

Setting the Scene mode
Select one of the following scene modes to fit your shooting condition.

Icon Mode Description

Smile Catch Automatically takes a shot when a smile is
detected.
Pre- Captures the background first, so the helper
composition can use it to take the final shot.
Downloade om ManualsCamera.com Manuals
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Icon Mode Description

HDR Increases the dynamic range and enhances
the details of dark areas.

Fisheye Simulates a fisheye lens effect and creates a
distorted hemisphere-like image.

Beauty Enhances the tone of skin so that the facial

Enhancer skin appears smooth.

Portrait Makes the subject (usually a person) stand

out with smooth and natural-looking skin
tones.

Self Portrait

Takes a self portrait with at least one face in
a confined area.

Love Portrait

Takes a self portrait with at least two faces in
a confined area.

Blink Detector

Warns of eye blinks if detected and lets you
decide whether to save the image file.

Night Portrait

Shoots night scenes and portraits clearly.
Please keep the camera steady or use a
tripod while using this mode.
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Icon Mode
Child

Description

Increases sensitivity and emphasizes
children's skin tones.

Sports Uses a high shutter speed to capture objects
in motion.
Mirroring Creates a mirror image effect.

Party

Captures the party atmosphere usually
under indoor light source.

MagiQ

Enhances the shadow and highlights the
details of an image.

Backlight

Increases exposure (by turning on the flash)
when light illuminates the subject from
behind.

Night Scene

Captures photos in a low-light environment,
such as in the evening or at night.

Fireworks

Adds exposure time to shoot firework trails.
Please keep the camera steady or use a
tripod while using this mode.
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Icon Mode Description

Landscape Captures a scene in the distance with the
focus area set to infinity and a lower
aperture value. The maximum depth of view
can also be achieved.

Foliage Takes a clear and vivid picture of flowers or
plant leaves by emphasizing their saturation
and sharpness.

Soft Flowing Uses a low shutter speed for motion blur.

Water Please keep the camera steady or use a
tripod while using this mode.

Sunset Captures the warmth and atmosphere
(represented by hue) of sunrise or sunset.

Snow Used under a very bright light environment

such as snow scenes.

7 |Colored Pencil

Captures the details in the image with fine
linear strokes to make the image appear as a
colored pencil drawing.

Web Auction

Reduces the file size for faster internet
upload.

Improves clarity & contrast when taking a
close-up picture of documents.
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Description

Voice Rec. Captures background sound only (no images

(Voice or videos). When listening to the captured

Recording) audio file later, you can see a unique icon
that appears on the screen and indicates that
this is an audio file.

To select a scene mode:

|. Set the mode dial to SCN.
2. Press MENU. The last selected scene mode

Night Scene
is highlighted on the menu option. Pl W
3. Press [@1C, or || to select the Landscape

Foliage

desired scene mode.

O 1

—
§&) Erter (G Back [ Info

o When you are selecting from different scene modes, slide the Zoom lever to W B

for detailed explanation of each scene mode. Slide the Zoom lever to QT to close
the scene mode description when you are done.

4. Press OK to confirm setting.

Smile Catch
Captures an image when the subject smiles.

. Set the mode dial to SCN.

. Press MENU and select Smile Catch.

. The camera is tracking the face of your subject (a white frame shows).
Once a smile is detected, the camera instantly takes a picture.

The camera continues to detect smiles and takes more pictures (Step 3 is
repeated).

IR

o Face tracking (one face only) is always on in the Smile Catch mode.
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Blink Detector

Automatically detects blinking when you capture an image.

I. Set the mode dial to SCN.

2. Press MENU and select Blink Detector.

3. Press the shutter to capture an image. If blinking is detected, a warning
message appears on the screen.

4. Press [_._] G or |O| to save or discard the image, and then press OK to
confirm.

Love Portrait

Takes a self portrait of at least two faces.

I. Set the mode dial to SCN.

2. Press MENU and select Love Portrait.

3. Once faces are detected, the camera will automatically take a picture after a
two-second countdown.

During the countdown, you can press the shutter to cancel the countdown. The
camera will then start detecting faces again.

4. The camera continues to detect faces and takes more pictures by repeating
Step 2. This face tracking will automatically stop if no faces are detected.

Fisheye
Simulates a fisheye lens effect and creates a distorted hemisphere-like image.
I. Set the mode dial to SCN.

2. Press MENU and select Fisheye.
3. Take a picture. (The Fisheye effect will be applied to this picture immediately.

s

Before After
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Pre-composition
Captures the background first for positioning the final image. ldeal for asking
others to take your photo.

I. Set the mode dial to SCN.

2. Press MENU and select Pre-composition.

3. Press the shutter to capture the background. The bottom section of the
screen displays the captured background image in a semi-transparent region.

4. Use the captured background image to frame the composition, and press the
shutter to capture the final image.

Web Auction

Combines a maximum of 4 shots into one single image on a VGA (640 x 480)
size, so it can be quickly used in situations such as Internet auctions. Each
picture can have different color effects.

|. Set the mode dial to SCN.
2. Press MENU and select Web Auction.

3. Press * or i to move to the number of shots you want to take, and then
press OK.

Icon Mode Description
E | shot Takes one picture only.
1
2 shots Takes two pictures based on the numeric

order shown below:

1l 2
3 shots Takes three pictures based on the numeric
order shown below:
2
1l 3
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Description

4 shots Takes four pictures based on the numeric
order shown below:

4. Press the shutter to take one picture.
5. If you are satisfied with the picture, press OK to take the next one.
* You can change another color effect (if needed). See "Effect Mode" on page
39 for details.
* If you want to re-take the previous picture, press MENU and repeat Step 3.
6. Once you have finished taking all pictures, the camera will automatically
combine these images into one.

Mirroring
Creates a mirror image effect.

I. Set the mode dial to SCN.
2. Press MENU and select Mirroring.

3. Press |O| to switch between horizontal mirror mode and vertical mirror
mode. The camera will reflect the image on the black section of the screen.

4. Press the shutter to capture the image.
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Using the Function menu

Press the Function button Fn-[I to access more capture options. Depending on
your settings, the displayed option icons in the Function menu may vary.

' | For print up to A3 Size. . |
} Approx. shots: 2131 Resolution

Movie size

EV Compensation

‘ 3264x2448 White — (EV)
=h Balance ISO
A m 3:25M 3M (g0 P>

) Metering —|
Effect

To use the Function menu:

I. Press Fn-m to enter the Function menu, the currently selected settings are
shown.

2. Press [_._]6 or |D| to select a menu item.

3. Press $ or i to select a setting.
4. Press OK to confirm the setting.
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Image size

Icon

Description
16 megapixels (4608 x 3456)

Description
3 megapixels (2048 x 1536)

3:2 (14 megapixels; 4608 x
3072)

HD 16:9

(1920 x 1080 in full HD
format)

m 8 megapixels (3264 x 2448) W | VGA (640 x 480)
m 5 megapixels (2592 x 1944) - |-
To select an image size:
I. Press Fn-mj > Resolution.
I. Press $ or i to select a setting.
2. Press OK to confirm setting.
Image quality
Icon Mode Description
Super Fine Best image quality with the lowest
compression rate. File size is the largest.
Fine Better imfige quality'wit'h m'edium'
compression rate. File size is medium.
Normal Good image quality with the highest
compression rate. File size is the smallest.

To select an image quality level:
I. Press Fn-m > Quality.

2. Press $ or i to select a setting.
3. Press OK to confirm setting.
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Movie size
Icon Description Icon Description
HD 720p (16:9; 1280 x 720) | gy |QVGA (320 x 240)
w  [VGA (640 x 480) [Ey | Web (640 x 480)

To select a movie size:
I. Press Fn-j > Video Format.

2. Press $ or i to select a setting.
3. Press OK to confirm setting.

Setting EV

EV (Exposure Value) lightens or darkens the
entire image. Adjust EV when the brightness
between the subject and the background is
not balanced, or when the subject occupies
only a small part of the picture.

To select an EV:

I. Press Fn-[g > EV Compensation.

2. Press $ or 5 to select an EV from the EV
bar.

3. Press OK to confirm setting.

White Balance

Compensates for color temperatures in different lighting conditions, so white
and other colors can display properly when you capture images.

Icon Mode Description

Auto Adjusts white balance automatically.
Daylight Used in bright daylight conditions.

Cloudy Used in twilight or shady conditions.
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Tungsten Used when subjects lit by tungsten
s (incandescent) lighting.

e Fluorescent H |Adjusts for fluorescent lighting. Corrects the
green hue of fluorescent lighting. Ideal for
= Fluorescent L  |indoor photos under fluorescent lighting
“ without a flash.
Manual Used when you want to manually adjust
= white balance in a particular lighting
condition.

To select White Balance:
I. Press Fn-Ij > White Balance.

2. Press $ or é to select a white balance option. The preview result based on
the currently selected white balance is shown on the screen. (When selecting
the manual mode, you must first point the camera at a blank sheet of white
paper or something similar and press the Shutter button for the camera to
detect proper colors.)

3. Press OK to confirm setting.

ISO

ISO configures the camera’s sensitivity to light. The higher the ISO value, the
brighter picture you can take in a low-light environment. Yet, you may see more
noise in the picture as you increase the ISO value.

Icon Description

Automatically sets the ISO value.
A\

Equivalent to color ISO 100/200 film. Used for outdoor
LE e photography in bright sunlight.

Equivalent to color ISO 400/800/1600/3200/6400 film. Used it
< B in 2 low-light environment or where the flash light is not

[1SO] [1SO] allowed.
1600 i 3200 Q6400

* ISO 6400/3200 for resolution of 3M/16:9/VGA under only

To select an ISO value:
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2. Press $ or i to select an ISO Value.
3. Press OK to confirm setting.

Metering
Icon Mode Description

() Matrix Detects the exposure based on multiple
points in the subject area.

(=) Cen. Weight Detects the exposure of the entire shooting
screen, but gives more importance to the
values near the center.

(-] Spot Detects the exposure based on the center
spot in the subject area.

To select a metering option:
I. Press Fn-m > Metering.

2. Press $ or 3 to select a metering option.
3. Press OK to confirm setting.

Effect Mode

Adds color filter effects to the image or video you want to capture.

Icon Mode Description
@ Normal No effects are added.
pry LOMO Creates a lomo-like effect by adding over
= saturated colors, dark corners, and so on.
E Vivid Adds an effect with very clear and bright
color tones.
E Sepia Adds an effect with dark reddish brown
color tones, so the image or video looks as if
it is old.

E Color Accent |Highlights the subjects by keeping the red
(Red) color domain of an image only while making
other regions black and white.
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lcon

Mode

Color Accent
(Green)

Description

Highlights the subjects by keeping the green
color domain of an image only while making
other regions black and white.

Color Accent
(Blue)

Highlights the subjects by keeping the blue
color domain of an image only while making
other regions black and white.

B/W (Black and |Adds an effect with monochromatic color
White) tones.

Vivid Red The image becomes reddish.

Vivid Green The image becomes greenish.

Vivid Blue The image becomes bluish.

After - when Color Accent (Green)

is applied

After - when Color Accent (Blue) is
applied
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To select an effect:
I. Press Fn-mm > Effect.

2. Press * or i to select a color mode option.
3. Press OK to confirm setting.

Recording Videos

You can record video with this camera. Set the movie size before you start
recording a video. See "Movie size" on page 37 for details.
To record the video clip:

Press @ to start recording.
Use the Zoom lever to zoom in/out on the subject.

l.
2.
3. Press [_._]6 to pause the recording. Press [_._] G again to resume.
4. Press @ to stop the recording.

o * Video recording will automatically stop when the video file size reaches 4 GB.
* Video recording at HD 720p (16:9; 1280 x 720) will automatically stop when the
video file size reaches 4 GB or the total recording time is near 29 minutes.
* Recording a video at HD 720p (16:9; 1280 x 720) requires a Class 6 or above
SDHC card.
* Videos captured in Web mode are stored under the XXXUTUBE directory (XXX
are numbers) with the file size limited to | GB or 10 minutes per video file (video
recording will automatically stop).

Using the Capture Menu

Press MENU to access the Capture Menu. In this menu, you can change the drive
mode and set up other capture settings.

I. Press MENU > (] .
Press [_._]6 or |O| to select a menu item.
Press OK or i to enter the submenu.

Press m or i to select the settings.
Press OK > MENU to save the setting and exit the menu mode.

vk W
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Setting the Drive Mode

This feature allows you to set the self-timer settings.

lcon Mode

10-sec./2-sec.
self-timer

Description

Automatically takes a picture after 2 or |0-
second delay. This mode is useful when you
want to be part of the picture.

=) Double

Performs delay and capture twice:
Performs a 10-second delay, then captures
the image.

Performs another 2-second delay then
captures the image again.

e Off (Single)

Takes one picture at a time.

To select a drive mode:

I. Press MENU > ] > Drive Mode.

2. Press OK or i, and then select a desired option.

3. Press OK > MENU.
Setting the AF Area

This feature determines the area on which the camera focuses.

To set the AF Area:

I. Press MENU > (] > AF Area.

2. Press OK or 3, and then select Wide or Center.

3. Press OK > MENU.
Using AF Assist Lamp

This feature allows you to add extra light when the lighting is insufficient while

capturing images.

To set the AF Assist Lamp:

I. Press MENU > (] > AF Assist Lamp.
2. Press OK or i, and then select ] or [ orF

3. Press OK > MENU.
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Setting Sharpness, Saturation and Contrast

Adjusts how colors appear in the pictures by setting sharpness, saturation, and
contrast.

To set sharpness, saturation, or contrast:

I. Press MENU > @], and then select Sharpness, Saturation, or Contrast.

2. Press OK or i and then select High, Normal, or Low.
3. Press OK > MENU.

Digital Zoom

The digital zoom enlarges or shrinks the image using a software process.
Icon Mode Description
IE." Wise Zoom Reduces the image size, and thus increases

the effective

zoom length without sacrificing image

quality.
Digital Zoom  |Turns on the digital zoom feature.
B Off Turns off the digital zoom feature.

To select a digital zoom:

I. Press MENU > []| > Digital Zoom.

2. Press OK or i, and then select a digital zoom type or [
3. Press OK > MENU.

Date Stamp
Imprints the date when a picture was taken on the picture itself.

To set the date stamp:
I. Press MENU > [ > Date Stamp.

2. Press OK or i, and then select Date, Date & Time, or .
3. Press OK > MENU.

Instant Review

This feature displays the still image that just recorded for | second.
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To set the Instant Review:
I. Press MENU > [ > Instant Review.

2. Press OK or 3, and then select m or .
3. Press OK > MENU.

o During instant review, half press the shutter to return to the capture mode.

Stabilizer
Reduces blur caused by camera vibration, and thus improves image quality and
clearness.

To set the Stabilizer:
I. Press MENU > (] > O.L.S..

2. Press OK or 3, and then select m or .
3. Press OK > MENU.

o When the battery power is low, the Stabilizer will be turned off automatically.

Battery status

Icon Description

Battery power is full.

Battery power remains adequate.

Battery power is low.

a Battery power is very low. You should replace the battery
ASAP.
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Other settings

Press MENU > [3z¢], and then select an option.

Icon Mode Description
Sounds [Startup] Sets a type of the startup sound.
[Shutter] Sets the shutter sound on and off.
[Operation] Sets the button (excluding shutter)

sound on and off.

[Volume] Adjusts the volume of the shutter
sound, startup sound, operation sound
and playback sound.

Power Saving E [I min] For power conservation, the camera

automatically enters the standby mode
EZ [3 min] after it has been idle for a period of
time. (Press any key to resume.)

EZ [5 min]

E [Off] The camera remains on when idle.

LCD Saving E [On] For power conservation, the LCD
screen is automatically dimmed after the
camera has been idle for 20 seconds.
(Press any key to resume.)

| The LCD screen remains bright when
o Jieli e
the camera is idle.
Date & Time Sets the date and time.
Language Select a language for display menus and other information.

File Numbering = ; Stores the most recently used file

[Series] number regardless of deleted files or a
change of memory card. This is useful
for avoiding the file name duplication
when images are downloaded to a
computer.

[Reset] Resets file numbering each time the
memory card is changed.
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Icon

TV Format

Mode Description

You can review images on a television with an AV cable.

[NTSC] America, Japan, Taiwan and others

[PAL] China, Europe, Oceania, and others

o TV Format should be set to either NTSC or PAL depending

on your region. For details about which system should be used,
check with your local authorities.

LCD Brightness

[Auto] The LCD brightness is automatically set
based on the surrounding environment.

[High] The LCD brightness is increased.

[Normal] The LCD brightness remains at the
default value.

Battery Type

To ensure the camera displays battery level correctly, set
the type to match the batteries used. Carbon-Zinc
batteries are not recommended.

[Alkaline] When using Alkaline batteries.

I [NiMH] When using NiMH batteries.

L}
HRG

[Lithium] When using Lithium batteries.

Manage Memory

B [Format] Formats the internal memory or the
memory card.

[Copy to Copies files from the internal memory
to the memory card.
Card]

Reset All

Resets the entire menu and button operation settings to
initial default.

The following settings do not change after Reset All:
Date & Time setting

Language setting

TV Out setting
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Playback mode

Press [®] to switch to Playback mode.
6

|
| — =] 019520 T
@ 08:05 ‘

5—7

IMG 0064.JPG

1.25MB
1/200 F2.8

5 —Alr S AL

o * If the camera is turned off, you can directly switch to Playback mode by pressing
and holding [®].

* While pausing video playback, you can press the Shutter button to capture the
video frame as a still image in the VGA format.

Item Description Page
reference

| Indicates that the camera is in Playback mode. --

2 |Indicates that the file is protected and cannot be 51
deleted.

3 Indicates this file has a voice memo or the file is an 51
audio file.

4 |Indicates the file is marked for printing. --

Displays the shooting parameters when you took the --

picture or playback controls. Press IO to toggle
between different displayed information.

6 Date and time when the file was created. --

7 File number --

8 |Histogram --
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Description Page

reference

9  |File name, file size, shutter speed, and aperture value -

Options for playback and editing

When the camera is in Playback mode, press $ or i to view the next/
previous recorded files. You can also select any of the following options.
Enlarging an image

Magnifies an image, so more details can be seen.

To enlarge an image:

I. Press [®] to switch to Playback mode.

2. Press m or 3 to select the image you want to enlarge.
3. Use the Zoom lever to zoom-in/out on the image.

4. Press [_._] G, |O| , *, or 3 to move to the area you want to see.
5. Press MENU to return to the normal viewing size.

Rotating an image

You can press [_._] G to change the orientation of an image at 90 degrees
clockwise at a time.

o For each rotation, the image file in the new orientation is automatically saved.

Viewing multiple files at a time

Shows up to 9 files at a time on the screen.

To view multiple files:

I. Press [®] to switch to Playback mode.

2. Slide the Zoom lever to QT. In this mode, maximum 9 files (shown in
thumbnails) are displayed on the screen. Press [_._] 6, |D| s *, or i to

select a file, and then press OK or MENU to view it in its normal viewing
size.
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3. Slide the Zoom lever to QT. In this mode, all files are arranged by dates.

Press [_..] ¢, |O| s *, or i to select a file, and then press OK or MENU
to view it in its normal viewing size.

o If there are more than 9 thumbnails, you can press i repeatedly until the scroll bar
is highlighted. Then you can press [@]C, to move to the previous 9 thumbnails or
|3 to move to the next 9 thumbnails. To cancel highlighting the scroll bar, just

press $

Playing back video clips
View recorded video clips in the playback mode.

To view a video clip:
I. Press [®] to switch to Playback mode.

2. Press $ or i to select the video clip you want to view.
3. Press OK to start playing the video clip.

« Press |3 to stop the video clip, or press [_._] G to pause it. Press

(@], again to resume.

o * During video playback, press i to fast forward or press w to rewind.
* While pausing video playback, you can press the shutter to capture the video
frame as a still image in the VGA format.

* While pausing video playback, you can view the video frame by frame. Press i to
fast forward one frame, or press m to rewind one frame. Press and hold i to

fast forward frame by frame continuously, or press and hold w to rewind frame
by frame continuously.

Adjusting the playback volume
Increase or decrease the volume of video clips, audio clips, or voice memos.

To adjust the playback volume:
I. Press [®] to switch to Playback mode.

2. Press $ or 3 to select a video clip, audio clip, or voice memo that you want

to play.
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3. Adjust the volume.
¢ To increase the volume, slide the Zoom lever to WE.
* To decrease the volume, slide the Zoom lever to QT.

o The volume can be set during playback, but not during rewind, fast forward, or
pause.

Slideshow
Sets the time interval for presenting a series of captured image and video files
(first frame only).

To play a slideshow:
I. Press [®] to switch to Playback mode.

2. Press MENU > [@‘ > Slideshow > QK or 3

3. Change the slideshow settings.
* Use the four-way control to set one of the following slideshow effects:

. Applies a transition effect from left to right.

Applies a transition effect from upper-left side to lower-right side.
. Applies a horizontal transition effect.

. Applies a vertical transition effect.

. E Applies a horizontal transition effect by intersecting an image.

* You can set the interval between 1/3/5/10 seconds.
4. Select whether you want to repeat the slideshow.

5. Select Start and press OK to play the slideshow.

o If you want to pause it at any time, press QK. Press OK again to resume playback.
To stop the slideshow, press MENU.

Deleting files

Removes selected or all files.

To delete files:

I. Press [®] to switch to Playback mode.

2. Press MENU > [ > Delete > OK or 3
3. Select whether to delete this selected file, voice memo only, other selected

file, or all files, and then press OK.
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Protecting files

Prevents selected files from accidental removal.
To protect files:

I. Press [®] to switch to Playback mode.

2. Press MENU > =] > Protect > OK or i

3. Select whether to protect this selected file, other selected file, or all files, and
then press OK. You will then see the icon & indicating the file is protected.

o You can remove the protection anytime by following the same procedure as shown
above. Note that in Step 2 the on-screen instruction will ask you how you want to
remove the protection.

Red-eye Removal

The Red Eye Correction function is used to reduce red eye in captured images.
This function is only available for still images. Red eye correction can be applied
to an image several times, but the quality may gradually deteriorate.

I. Press [®] to switch to Playback mode.

2. Press $ or i to select the image you want to apply Red-eye Removal.

3. Press MENU > [=) > Red-eye Removal > OK or *3
4. Press OK to confirm the change and save the image file.

o You cannot use this function on images captured in Panorama mode.

Voice memo
Inserts a voice annotation to an image file.

To record a voice memo:
I. Press [®] to switch to Playback mode.

2. Press $ or i to select the image you want to add a voice memo.

3. Press MENU > [=] > Voice Memo > OK or -3
4. Select Start > OK to start your voice recording.
5. Select Stop > OK to stop recording.

To play back a voice memo:

|. Press OK to play the voice memo.
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2. Press [_._] G to pause the playback.

3. Press [_._] G to resume the playback.

4. Press MENU to exit playback.
Photo Effect

You can add special effects to your images.

Icon Mode Description

@ Normal No effect is added to the image.

E Sepia Recorded image will be stored in a sepia
tone.

@ B/W Convert image to black & white.

E Negative Colors become the opposite of what they
were in the original image.

E Mosaic Applies 2 mosaic tile effect to the image.

E Vivid Red The image becomes reddish.

E Vivid Green The image becomes greenish.

E Vivid Blue The image becomes bluish.

To add a special effect to an image:
I. Press [®] to switch to Playback mode.

2. Press m or i to select the image you want to add an effect to.

3. Press MENU > & > Photo Effect > OK or i

4. Press m or 3 to select the effect.
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5. Press OK to confirm the change and save the image file.

Photo Effect...

o You cannot use this function on images captured in Panorama mode.

Trimming
Crops part of an image file, reduces the image size, and overwrites the image file
or saves it as another new file.

To trim an image:
I. Press [®] to switch to Playback mode.

. Press $ or i to select the image you want to trim.

2

3. Press MENU > > Trim > OK or 3.

4. Use the Zoom lever to select the target image size (8M, 5M, 3M, VGA) to
which you want to reduce.

Press [!]6, |O|, *, or i to locate the area to trim.

6. Press OK to confirm the change and save the image file.

o

o You cannot trim images in the size of 3:2, 16:9, or VGA, or images captured in
Panorama mode.

Resizing
Changes an image file to a smaller size, and overwrites the image file or saves it
as another new file.

To resize an image:
I. Press [®] to switch to Playback mode.

2. Press $ or 3 to select the image you want to resize.
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4. Press [_..] G or |O| to select the target image size to which you want to
reduce.
5. Press OK to confirm the change and save the image file.

o You cannot resize images in the size of 3:2, 16:9, or VGA, or images captured in
Panorama mode.

Startup image
Sets the welcome screen when the camera is powering on.
To select a startup image:
I. Press [®] to switch to Playback mode.
2. Press MENU > [= > Startup Image > OK or i
* To use the default startup image, select Default.
* To use a custom image, select My Photos and press * or i to select an
image.
* To disable the startup image, select Off.
3. Press OK.

DPOF

The Digital Print Order Format (DPOF) setting allows you to select images on
the memory card for printing and specify the number of print copies in advance
using the camera. This is extremely convenient for sending the images to a
photo developing service or for printing on a direct print function compatible
printer.

To set up DPOF:

I. Press [®] to switch to Playback mode.

2. Press MENU > (& > DPOF.

3. Press [_._] G or |D| to select one of the following options.
* To set the DPOF setting for one image in a time, select One. Press $ or

4 to select an image.
* To set the DPOF setting for all images in a time, select All.
* To clear all DPOF settings to initial default, select Reset.
4. Press [_._] G or |O| to specify the number of copies.

5. Press nég'%éo decide whether you want to turn the date stamp on.
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6. Press OK.
Radial Blur
Applies a rotating motion effect to give a feel of speed.

To apply a Radial Blur effect:
I. Press [®] to switch to Playback mode.

2. Press MENU > [[& > Radial Blur > OK or i
3. Press [_._]6 or |D| to select a degree of Radial Blur.

4. Press OK to confirm the change and save the image file.

o You cannot use this function on images captured in Panorama mode.
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Working with computer and AV system

Bundled software

The camera offers the following programs on a CD.

MAGIX Video easy |MAGIX Video easy SE is an intuitive video editing

SE program. Simply select your video, add text, music and
transition effects to create your own movie. Burn your
movie into DVD, export to mobile devices, or present
your videos on the Internet.

To install these programs, see the information supplied with the CD.

Connecting the camera to a computer

You can connect the camera to a PC or notebook to transfer, view, print, or edit
files.

To connect the camera to a computer:

I. Open the USB/AV port cover.

2. Connect the end of the smaller plug of the USB

cable to the camera.

. Turn on the camera.

4. Connect the other end of the USB cable to an
available USB port on your computer.

5. Select Computer and wait for the connection.

6. A Removable Disk icon appears in My Computer. Click this icon to access
the files in your camera.

w

* When connecting the camera to a computer, it is necessary to install a battery
o into the camera.
* When connecting the camera to a computer, please use the original accessory of
the USB cable to avoid possible system conflicts and damage to the camera.

Connecting the camera to an AV system
You can play files in your camera from an AV system such as TV or projector.

To connect the camera to an AV system:
I. Open the USB/AV port cover.
2. Connect the end of the smaller plug of an AV cable to the camera.
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3. Connect the yellow video plug and the white audio plug of the AV cable to a
video-input jack and an audio-input jack (left channel) on your AV system.

4. Turn on the AV system, and then switch to the AV source connecting to the

camera.

Turn on the camera.

6. Follow the on-screen instructions to operate the camera via the TV or
projector screen.

“o

Printing images
In addition to printing images by connecting the camera to a printer via a

computer or bringing the memory card (if available) to a photo-processing
center, you can choose to print using PictBridge.

Printing with PictBridge
You can directly print images by connecting your camera to a PictBridge-
compatible printer without using a computer.

To print images from a PictBridge-compatible printer:

I. Open the USB/AV port cover.

2. Connect the end of the smaller plug of the USB cable to the camera.

3. Connect the other end of the USB cable to an available USB port on your
printer.

4. Turn on the printer. Wait for a while until it finishes starting up and is ready
to print.

5. Turn on the camera.

Select Printer and wait for the connection.

7. Select one of the following options:

o

* To print one image at a time, select Print Select, and press * or i to
select an image.
* To print all images at a time, select Print All.
* To print all images (shown by thumbnails) at a time, select Print Index.
8. Press OK.

* The above procedure may vary depending on the printer type you are using.
o * If you connect the camera to your printer while the printer is still starting up, the
camera will be automatically turned off.

* Failure to follow the above procedure will make the camera show an error
message. Please disconnect the camera and the camera will be automatically
turned off.
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Troubleshooting and service
information

If your camera cannot operate normally, see the frequently encountered
problems and solutions listed below. If the problem persists, contact your
nearest service center or technical support.

Problem

The camera
cannot power

up.

Cause

There is no battery or the
batteries are not inserted
correctly.

Solution

Insert the batteries correctly.

The batteries have no
power.

Replace the batteries.

The battery
power is
draining quickly.

The external temperature is
extremely low.

Many shots are being
captured in dark places,
requiring a flash.

The batteries or

camera is warm.

The camera or flash was
used continuously over a
long period of time.

The LCD
screen is black.

The lens cover is on.

Remove the lens cover.

No image is
displayed on the
screen and the
camera beeped
three times.

The lens cover is on.

Remove the lens cover.

| cannot adjust
the flash mode.

The flash is closed.

Open the flash.

The flash does
not fire.

The camera flash is turned
off.

Set the flash to Auto Flash.

The light source is
sufficient.
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Problem

Even though the
flash fired, the
image is dark.

Cause

The distance to the subject
is greater than the flash's
effective range.

Solution

Get closer to the subject and
shoot.

The image is
too bright or
too dark.

The exposure is excessive
or inadequate.

Reset exposure compensation.

| cannot format
a memory card.

The memory card is write-
protected.

Remove the write protection.

End of the memory card
life.

Insert a new memory card.

| cannot
download
images from the
camera to my

The free space on the hard
disk of your computer is
insufficient.

Ensure that the hard disk has
enough space for running
Windows and that the drive for
loading image files has free

computer. space equal to or greater than
the memory card in the camera.
There is no power being Replace the batteries.
supplied to the camera.
The camera The batteries are running  |Replace the batteries.
does not shoot |low.
even when

pressing the
Shutter button.

Downloaded fr

The camera is not in
Capture mode.

Switch to Capture mode.

The Shutter button was not
pressed all the way down.

Press the Shutter button all the
way down.

The internal memory or
memory card does not have
any free space.

Load a new card or delete
unwanted files.

The flash is recharging.

Wait until the flash mode icon,
indicated on the screen, stops
flashing.

The camera does not
recognize the memory card.

hm ManualsCamera com M

Format the memory card
before the initial use or before
using with another camera.
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Solution

Problem

| cannot print | The camera is connected to |Connect the camera to the

images with the printer when the printer, turn on the camera, and
PictBridge- camera is powered off. then select Printer.

compliant

printers.

Technical support
For technical assistance, free driver updates, product information, and news

releases, visit the following web site:
http://www.BenQ.com
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Specifications
Sensor Sony 16 Mega Pixels, 1/2.3 inch CCD
Zoom Optical: 21X
Digital: Up to 5X (Preview) / Up to 12X (Playback)
Lens f=4.5(W)~94.5(T) mm

F=3.1 (W)~5.8(T)
(f =25 mm ~ 525 mm, 35 mm equivalent)

Focus Range

Normal: W = 50 cm ~ Infinity; T = 500 cm ~ Infinity
Macro: W = 2 cm ~ Infinity; T = 60 cm ~ Infinity
Super Macro: 1 cm (M) ~ Infinity

LCD

3.0” LCD 460k pixels

Image Resolution

16M/3:2/8M/5M/3M /16:9/ VGA

Movie Mode HD 720p (1280 x 720) / VGA (640 x 480) / QVGA (320 x
240) / Web (640 x 480)
30 fps, Continuous recording with sound

Shutter Speed Auto: 1/2000 ~ 1 sec.

Manual mode: 1/2000 ~ 15 sec.
(Fireworks 2 sec.; Night Scene 1/2000 ~ 15 sec.)

White Balance

Auto / Daylight / Cloudy / Tungsten / Fluorescent H /
Fluorescent L / Manual

Exposure -2.0 ~+2.0 EV (0.3EV / step)

ISO Auto / 100 / 200 / 400 / 800 / 1600 / 3200 (3M or lower) /
6400 (3M or lower)

Flash Auto Flash / Auto Anti Red-eye / Forced On / Slow Sync /
Forced Off

Drive mode Off / 10 sec. / 2 sec. / Double

Power Source

CIPA approximately 330 (based on bundled AA Alkaline
batteries); 500 based on NiMH batteries; 850 based on
Lithium batteries)

Storage Type

Built-in approx. 108MB (+-5%)
SD (up to 4GB) / SDHC (up to 32GB) / SDXC (> 32GB)

File Format

Downloaded frol

Still Image: JPEG (EXIF 2.3 compatible); DCF compatible;
Support DPOF
Video: MUPEG
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Dimensions / 112.5 x 75.9 x 63.4 mm
Weight 355g (w/o batteries & SD card)
Interface Digital output: USB 2.0 compatible
Audio / Video output (NTSC/PAL)
PictBridge compatible
Accessories USB Cable / Software & User Manual CD / Quick Guide /

Lens Cover / Lens Strap / Neck Strap / Non-rechargeable AA
Batteries / Pouch (optional)

0 Available accessories depend on the actual items shipped

and may vary from the list above.

o All information, designs, and specifications are subject to change without prior

notice.

Downloaded from ManualsCamera.com Manuals



http://manualscamera.com

	Touring the camera
	Checking the package contents
	Camera
	Front and bottom views
	Rear view

	Multifunctional buttons

	Preparing the camera for use
	Attaching the strap
	Installing the batteries
	Installing an SD card
	Turning the Power On and Off
	Opening the Flash

	Initial setting
	Setting language
	Setting date and time

	Operating the camera
	Capture mode
	Flash mode
	Face Tracking
	Focus mode
	Selecting the Shooting Mode
	Using Aperture Priority mode
	Using Shutter Priority mode
	Using Manual mode
	Using Continuous Shooting mode
	Using Panorama mode
	Using Smart Scene mode
	Setting the Scene mode
	Smile Catch
	Blink Detector
	Love Portrait
	Fisheye
	Pre-composition
	Web Auction
	Mirroring


	Using the Function menu
	Image size
	Image quality
	Movie size
	Setting EV
	White Balance
	ISO
	Metering
	Effect Mode

	Recording Videos
	Using the Capture Menu
	Setting the Drive Mode
	Setting the AF Area
	Using AF Assist Lamp
	Setting Sharpness, Saturation and Contrast
	Digital Zoom
	Date Stamp
	Instant Review
	Stabilizer

	Battery status

	Other settings
	Playback mode
	Options for playback and editing
	Enlarging an image
	Rotating an image
	Viewing multiple files at a time
	Playing back video clips
	Adjusting the playback volume
	Slideshow
	Deleting files
	Protecting files
	Red-eye Removal
	Voice memo
	Photo Effect
	Trimming
	Resizing
	Startup image
	DPOF
	Radial Blur


	Working with computer and AV system
	Bundled software
	Connecting the camera to a computer
	Connecting the camera to an AV system
	Printing images
	Printing with PictBridge


	Troubleshooting and service information
	Technical support

	Specifications

